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1 Introduction

Our philosophy at Crucial Software is to ensure the complete satisfaction of all clients
who purchase the Libris Professional Facility and Resource Scheduling system.  We
believe that the key to ensure such a thing is to provide you with a state of the art fully
functional software system, coupled with the most comprehensive user support available.

To that end, this Training Guide serves to guide you through the process of setting up
the Libris system and its every day usage.  Our goal is for you to become comfortable
with the new features of Libris Professional and for this product to become an integral
part of your facility and resource management operations.

Further, we seek to help new clients learn the basics and get their system implemented
to meet their business needs.  Throughout this manual you will find valuable
implementation tools and suggestions to help you to take full advantage of the CS Libris
Professional, Facility and Resource Management Software System.
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2 Installing Libris

There are three different ways in which you may wish to install Libris.  If you a planning
to use Libris on a single computer then see section 2.1 Installing Libris for use on a
single computer below.  If you have a copy of SQL Server then see section 2.4 Installing
Libris Database for SQL Server below.  Otherwise see sections 2.2 Installing Libris
Server and 2.3 Installing Libris Client.

2.1 Installing Libris for use on a single computer

1. Make sure you are not running any other programs.  THIS IS IMPORTANT.  The
installation process will install the Microsoft Database Engine and this will
automatically restart your computer.

2. If you are using the Libris CD click on the Libris Single User Installation option in
the menu that comes up when you insert the CD.  If you have downloaded the
installation routine from the Crucial Software web site then run the
InstallSingle.EXE program that you downloaded.

3. You should see a window headed Libris 2 Installation.
4. You may see a message telling you that you need the Microsoft Data Access

Components.  If you see this message these will automatically be installed now and
the computer will then restart.  The install process will start again automatically
after the restart.

5. You may see a message telling you that the Windows Installer is being installed.  If
you see this message, once the Installer is installed the computer will automatically
restart.  The Libris install process will start again automatically after the restart.

6. Click Next.
7. You will see a window telling you that the Microsoft Database Engine (MSDE) is

about to be installed.
8. Click Next.
9. The installation process will now install the MSDE, this may take a few minutes so

please be patient.
10. The computer will restart.
11. The installation will automatically run again after the computer has restarted.
12. You will see a window telling you that the MSDE has successfully been installed.
13. Click Next.
14. You will see a window asking for the Destination Location.  Do not change the

Desination Folder unless you have an important reason to install Libris in to a
different folder.

15. Click Next.
16. You will now be asked whether you wish to install the sample database or an empty

database.  If you are installing a trial system it is recommended you install the
sample database to see an example of how Libris can be set up.

17. Click Next.
18. The Libris Client will now be installed.
19. You will see a window telling you that Libris has been successfully installed.
20. Run Libris.  The first time you run Libris it will check the integrity of the database,

this may take up to 2 minutes.  Please be patient, this will not happen the next time
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you run Libris.
21. You will be asked to log in to Libris and enter a password.  Libris requires a

password of at least 6 characters.  Please make a note of the log in you use here,
this will become the administrator login for Libris.

22. You have now completed the installation of Libris.

Note: You may install the Libris Client on to other computers if you wish (see below),
but please note this computer must be switched on before those other computers
can run Libris.  If you wish to do this the please make a note of this computer's
name because this will be needed for the other computers.

2.2 Installing Libris Server

1. Make sure you are not running any other programs.  THIS IS IMPORTANT.  The
installation process installs the Microsoft Database Engine and will automatically
restart your computer.

2. If you are using the Libris CD click on the Libris Server Installation option in the
menu that comes up when you insert the CD.  If you have downloaded the
installation routine from the Crucial Software web site then run the
InstallServer.EXE program that you downloaded.

3. You should see a window headed Libris Server 2 Installation.
4. You may see a message telling you that you need the Microsoft Data Access

Components.  If you see this message these will automatically be installed now and
the computer will then restart.  The install process will start again automatically
after the restart.

5. You may see a message telling you that the Windows Installer is being installed.  If
you see this message, once the Installer is installed the computer will automatically
restart.  The Libris install process will start again automatically after the restart.

6. Click Next.
7. You will see a window telling you that the Microsoft Database Engine (MSDE) is

about to be installed.
8. Click Next.
9. The MSDE will now be installed.  This may take a few minutes so please be

patient.
10. The computer will restart.
11. The installation will automatically run again after the computer has restarted.
12. You will see a window telling you that the MSDE has successfully been installed.
13. Click Next.
14. You will see a window asking for the Destination Location.  Do not change the

Desination Folder unless you have an important reason to install Libris in to a
different folder.

15. Click Next.
16. You will now be asked whether you wish to install the sample database or an empty

database.  If you are installing a trial system it is recommended you install the
sample database to see an example of how Libris can be set up.
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17. Click Next.
18. The Libris Database will now be installed.
19. You will see a window telling you that Libris has been successfully installed.
20. Please make a note of this computer's name because this will be needed for

installing the Libris Client on the other computers.
21. You have now completed the installation of the Libris Server.

You should now proceed to installing the Libris Client on the users' computers.

2.3 Installing Libris Client

1. Make sure you are not running any other programs.  THIS IS IMPORTANT.  The
installation process may need to install the Microsoft Data Access Components and
this will automatically restart your computer.

2. Do not run this unless you have already installed the Libris Server or installed a
Libris Database into your SQL Server.

3. If you are using the Libris CD click on the Libris Client Installation option in the
menu that comes up when you insert the CD.  If you have downloaded the
installation routine from the Crucial Software web site then run the InstallClient.EXE
program that you downloaded.

4. You should see a window headed Libris Client 2 Installation.
5. You may see a message telling you that you need the Microsoft Data Access

Components.  If you see this message these will automatically be installed now and
the computer will then restart.  The install process will start again automatically
after the restart.

6. You will see a window asking for the Destination Location.
7. Do not change the Desination Folder unless you have an important reason to install

Libris in to a different folder.
8. Click Next.
9. You will see a window asking for the Server Name, Database Name and Database

Password.
10. Enter the Server Name that you noted down in step 20. of the Libris Server

Installation above.
11. Do not change the Database Name or Password unless you are using a full version

of SQL Server, in which case you will need to get this information from your
Database Administrator.

12. Click Next.
13. You will see a window asking you to start the installation.
14. Click Next.
15. The Libris Client will now be installed.
16. You will see a window telling you that Libris has been successfully installed.
17. Run Libris.  The first time you run Libris it will check the integrity of the database,

this may take up to 2 minutes.  Please be patient, this will not happen the next time
you run Libris.

18. You will be asked to log in to Libris and enter a password.  Libris requires a
password of at least 6 characters.  Please make a note of the log in you use here,
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this will become the administrator login for Libris.
19. You have now completed the installation of Libris.

2.4 Installing Libris Database for SQL Server

a. Make sure you are not running any other programs.  THIS IS IMPORTANT.  The
installation process may need to install the Microsoft Data Access Components
and this will automatically restart your computer.

b. Click on the Libris Database Installation option.
c. You should see a window headed Libris 2 Database Installation.
d. You may see a message telling you that you need the Microsoft Data Access

Components.  If you see this message these will automatically be installed now
and the computer will then restart.  The install process will start again
automatically after the restart.

e. You may see a message telling you that the Windows Installer is being installed.
If you see this message, once the Installer is installed the computer will
automatically restart.  The Libris install process will start again automatically after
the restart.

f. Click Next.
g. You will see a window asking for the Destination Location.  Do not change the

Desination Folder unless you have an important reason to install Libris in to a
different folder.

h. Click Next.
i. You will now be asked whether you wish to install the sample database or an

empty database.  If you are installing a trial system it is recommended you install
the sample database to see an example of how Libris can be set up.

j. Click Next.
k. The Libris Database will now be installed.
l. You will see a window telling you that Libris has been successfully installed.
m. Please make a note of this computer's name because this will be needed for

installing the Libris Client on the other computers.
n. You have now completed the installation of the Libris Database.

Note: The standard installation for SQL Server works only with SQL Server 2000 or
MSDE 2.0.  If you have SQL Server 7 or MSDE 1.0 then contact Crucial Software
for the appropriate installation routine.

You should now proceed to installing the Libris Client on the users' computers.

2.5 Installing Libris Web Viewer

To install the Web Viewer you need to first ensure that the Microsoft Internet Information
Server (IIS) version 4.0 or later is installed (see Microsoft documentation to find out how
to install this).  This comes included with Windows 2000 or XP Professional but is not
installed automatically.
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Once you have IIS installed you are ready to install the Libris Web Viewer.

1. The Web Viewer needs to be installed on the same computer as the IIS.
2. Run the Libris Web Viewer install program (InstallWeb.EXE)
3. Follow the instructions on screen and click Next.
4. Check the installation directory for the Web Viewer is suitable and click Next.
5. Enter the name of the computer where the Libris Server (MSDE) is installed (or

the name of the SQL Server with the Libris database attached – changing the
ID and password accordingly).

6. Click Next.
7. Click Next once more to begin the installation.
8. Once the Web Viewer has been installed click Finish.

Before you can start using the Web Viewer you need to tell the IIS where the Web
Viewer is located as follows:

1. Select Settings and the Control Panel from the Windows Start menu.
2. Select Administrative Tools and then the Internet Services Manager.
3. Open up the "local computer" option on the left hand panel.
4. Open up "Web Sites".
5. Right click on "Default Web Site" and select "New" and then "Virtual

Directory…"
6. Click Next.
7. Enter a directory alias, e.g. "Libris" or "Diary".
8. Click Next.
9. Select the directory where the Web Viewer was installed (selected in step 4. of

the Web Viewer installation) followed by \Documents.  If you kept the default
this will be "C:\Program Files\Crucial Software\Web Viewer 2\Documents".

10. Click Next.
11. Tick the boxes "Read" and "Run scripts (such as ASP)".
12. Click Next.
13. Click Finish.

If you are running IIS 6.0 (Windows Server 2003) you will need to enable Active
Server Pages.

1. Load IIS from the Administrative tools in the Control Panel by clicking Start ->
Administrative Tools -> IIS Manager (or loading the Control Panel, entering the
Administrative Tools folder, and double clicking IIS Manager)

2. Go to the Web Service Extensions tab, click Active Server Pages, then press
the "Allow" button on the left.

The Web Viewer should now be operational.  To run the Web Viewer run Internet
Explorer on any computer and then enter the web address of http://server/Libris where
server is the name of the computer you installed the Web Viewer on (the IIS computer)
and Libris is the alias you entered in step 7. of setting up the IIS.
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3 Starting Up Libris

As soon as you open Libris, you will see the screen that you will be using most of the
time:-

Occupying the largest part of the screen is a Booking Chart on which bookings will be
displayed as horizontal bars.

Across the top of the Chart is the Timeline, a horizontal ruler which can show dates, or
dates and times, according to its scale.

Vertically, down the left side of the Chart, is the Facilities column in which are listed the
facilities that you have to allocate, such as:-

a. rooms, vehicles,  personnel (whatever you book out)

b. resources, such as projectors or lecterns, and

c. services, such as caterers, or language signers.

When you first see the Booking Chart, the only entry in this left-hand column is the entry
"Main", which is a unique entry, encompassing all the facility entries that you will make. 
This will become more clear when you are yourself recording facility entries.  

The procedure for Recording Facilities is the subject of a later section.
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As soon as facilities have been recorded, they can be allocated using the Booking
Procedure which is described later, in the Making Bookings section.

Immediately above the Timeline on the Booking Chart there is a Tool Bar in which are
displayed a number of icons. 

To display the meaning of Tool Bar icons:

· Using the mouse, move the pointer on the screen so that its tip rests on an icon to
open an information box showing the meaning of the icon.  

If you were now to click the left mouse-button the indicated action would be initiated.

Above the Tool Bar is a Menu Bar on which is a row of single words, each one of
which is the name of a menu. 

To open a menu from the Menu Bar:

· Move the pointer to a word on the menu bar.

· Click the left mouse-button to open a pull-down a menu.

You could now initiate an action by moving the pointer to one of those listed in the
menu and clicking the left mouse-button.
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A Note for the Expert:

It is the intention of these first few sections to assume little or no prior
hands-on experience of computers or computer systems; rather as if the
reader were somebody left alone to fend for him or herself, Libris just having
been installed for them.  If you are used to computers and their ways, please
remember that so many of the things which now seem intuitive to you, are
really no more than conventions with which you have become familiar; and
also, just how daunting it could be when you had no idea what to do next, no
clear idea what any of the buttons might do, and no guarantee that a single
false move might not lead directly to a complete, totally irreversible,
appallingly expensive, and deeply embarrassing break-down, lock-in or
burn-out.
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4 Setting Up Libris

Before using Libris you will need to set up Libris for the particular way in which you
intend to use the system.

4.1 Settings

Before you can create the items you wish to book there are a number of things you need
to decide about and set up.  These settings can be access by going to the Tools menu
on the main screen and selecting Settings.

4.1.1 Facilities, Resources and Services

In Libris there are a number of things that you can book: Facilities, Resources and
Services.

Facilities are the main items that you intend to book in Libris.  These could be rooms,
vehicles, people, playing fields, tennis courts, etc.

Resources are items that you can book to use within or in addition to a facility.  These
could be video or audio equipment, furniture, training equipment, etc.  A resource, like a
facility, can only be booked once at a particular time.

Services are additional items that can be booked but are not limited in number.  These
may be catering services, security, extra staffing, etc.  Services could also be items of
which there are such a large number that keeping track of them as individual resources
would be unworkable.

4.1.2 Facility Types

Before you create the items you wish to book in the system you need to set up the
different types of facilities you have.  For example, if your facilities are rooms, you may
have a number of different classifications of rooms: conference rooms, meeting rooms,
dinning rooms, theatres, and so forth.  You also use the facility type for other sorts of
facilities you wish to book such as Limousines, Coaches, Personnel.  You can then
report on the usage of different types of facility (see Chapter 12).

To set up the Facility Types, select Settings from the Tools menu on the main screen,
then click Facility Types in the left hand panel of the System Settings window (see
below).
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To create a new Facility Type click on the  New Facility Type button to bring up the
following screen.

Enter the name of the type in the Facility Type box
and, optionally, an email address to send a
confirmation email to when a booking is made for a
facility of this type.

Then click OK.

4.1.3 Resource Types

Before you can set up resources you need to set up the different categories of resources
. In the System Settings window click on Resource Types in the list on the left, to show
Resource Types in the window on the right, which will, at first be blank.  See below.



16 Libris 2

© 2003-2005 Crucial Software Ltd

Click on the  New Resource Type button on the left of the bar to reveal the window
below:

Enter the Resource Type and, optionally, a Lead
Time and E-Mail address, then click the OK button.

The Lead Time is the amount of time before a
booking of a resource of this type is due to start that it
must be made.  I.e. if you have a lead time of one
hour, and you want to book it to use at 3pm then you
must make the booking no later than 2pm on that
day.

The e-mail notification address is used when Libris
sends out email confirmations.  The email
confirmation will be sent to this email address
whenever a resource of this type is included on a
booking.

Once you have clicked OK your entry will appear in the System Settings window.

4.1.4 Service Types

Before you can set up services you need to set up the different categories of services.

In the System Settings window click on Service Types in the list on the left, to show
Service Types in the window on the right, which will, at first be blank (see below).
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Click on the  New Service Type button on the left of the bar to reveal the window
below:

Enter the Service Type and, optionally, a Lead Time
and email address, then click the OK button.

The Lead Time is the amount of time before a booking
of a service of this type is due to start that it must be
made.  I.e. if you have a lead time of one hour, and
you want to book it to use at 3pm then you must make
the booking no later than 2pm on that day.

The e-mail notification address is used when Libris
sends out email confirmations.  The email
confirmation will be sent to this email address
whenever a service of this type is included on a
booking.

Once you have click OK your entry will appear in the System Settings window.

4.1.5 Feature Types

When you set up facilities, they can been given a number of features such as Network
points, Whiteboards, Air Conditioning, as so on.  Before you set up your facilities you will
need to set up the various different types of Features.  In the System Settings window,
click on Feature Types in the left hand panel to get the screen below.
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Click on the  New Feature Type button on the left of the bar to reveal the window
below:

Enter the name of the Feature Type and then click OK.

4.1.6 Booking Types

When making a booking you may wish to distinguish between different types of booking. 
For example, you may wish to distinguish between bookings for different purposes like
internal meetings, external meetings, training sessions, etc.  Or you may wish to use the
booking type to indicate the status of the booking, i.e. whether it has been confirmed or
just provisional.  In the System Settings window click on Booking Types in the left hand
panel to produce the window below.

Click on the  New Booking Type button on the left of the bar to reveal the window
below:
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Enter a description for the booking type and then
select a colour to show for bookings of this type
in the booking chart.  The alternate colour is
used in the booking chart to indicate bookings
made by users other the one currently viewing
the booking chart.

If you have the web viewer you will also be given
an option to hide bookings of this type from the
web viewer.

4.1.7 User Settings

There are number of options to help you adjust Libris to work the way you want it to.  To
view and change these settings click on User Settings in the left hand panel of the
System Settings window and you should see the window as shown below.
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There are many options here, to find details about the complete list see Appendix A in
the manual.  To change a setting, click on the heading in the left hand half of the list and
then change the value in the right hand half.  To help you determine what value you
should use a description of the setting is shown in the panel below the list.

4.1.8 Default Availiability

When setting up Libris you need to determine the days and times on which bookings
may be made.  In the System Settings window select Default Availability in the left
hand panel.
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Here you can set up when all facilities will be available (you can override this for each
facility when you set it up).

To add one or more new sessions when bookings can be made click on the  Add New
Session button to produce the window below.

Select the day or days you wish to add a session of availability to, then select a start and
end time and click OK.

To edit or delete a session of availability click on the session you wish to work with (the
border will get thicker) and then click on the  Delete Availability Session button or
the  Edit Availability Session button.
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4.2 Folders, Facilities, Resources & Services

Libris allows for the possibility that your facilities (rooms, vehicles, etc), resources and
services may be organised in groups, whether for geographic, logistical or some other
reason.

Such a group might be a single building, or a complex of buildings that are near to one
another and use common services.  Similarly, it could refer to a fleet of vehicles which
are garaged, serviced or controlled at or from the same location.  

If your facilities are organised in groups in this way, then the next step is to record  the
group names as folders to contain the groups of facilities.

Folders are indicated by a  or  symbol, facilities by a  or  symbol,

resources by a  and services by a .

4.3 New Folders

To create a new Folder follow the steps listed below:-

a. Select Main in the Facilities column to the left of the Booking Chart, by clicking on
it.
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b. Select New Item from the Edit menu.

c. Keeping New Item
highlighted, move the mouse
to the right and another
menu will fly out to the right,
offering you the choice of:

i. New Folder
ii. New Facility
iii. New Service, and
iv. New Resource.

d. Select the  New Folder button and a form, labelled Folder Properties will appear
in the centre of the screen.

At this stage, to get started, the only information that you will need to supply is the 
Name - the name of the group, building, complex, fleet, base etc. 

All folders can contain facilities, but you have to select whether the folder will
contain resources and/or services by ticking the box by "Folder contains Resources"
or "Folder contains Services".

If you have the Web Viewer module, you can also select whether bookings of items
within this folder will appear in the Web Viewer.

On the right hand side of this window you can select the access rights for User
Groups - see Chapter 14 for more details about Access Rights and User Groups.

Click OK and this folder will now appear in the Facility List on the left hand side of
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the main screen.

4.4 New Facilities

In the list of folders in the Facilities Column on the left of the Booking Chart, highlight
the folder in which you want the facility to be recorded (by clicking on it).

Move the pointer to the Menu Bar at the top of the Booking Chart, and click Edit 3 New
Item 3 New Facility to reveal a Facility Details form:-

You can now fill in the details that you wish to record at this time.  On the Details page
you can enter:

a. Name
Enter the name of the facility that you wish to see on booking forms and reports.

b. Within
You can change the folder or facility that contains this new facility by selecting
something different from the tree in the box headed within.

c. Facility Type
Select the type of facility for use in searches and reports.

d. Description
(Optional) Enter further details about this facility.  This field is just for information
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purposes.

e. Location
(Optional) Enter a description of the location of this facility.  This field is just for
information purposes.

f. Capacity
Where your facility is a room, then you can select the maximum capacity of the
room.  If you attempt to make a booking that exceeds this capacity you will be
warned or prevented from making the booking (depending upon a User Setting).

g. Availability
Here you select when the facility will be available for bookings.  If you select
Default Availability then the facility is available on the days and times selected in
Default Availability in the System Settings window.  If you select one of the other
options an extra page tab Availability will appear at the top of the window, this
extra page will enable you to enter when this facility is available for bookings. 
Select By Day of the Week if the facility is available on the same days every week,
select By Date and Time if you want to select particular dates on which this facility
is available.  On example of using By Date and Time is when your facilities are
staff that have different that work rosters each week.

h. Available From
If this facility is not immediately available for bookings, for example, it is a new
room that is being built, you can enter the first date on which a booking may be
made in this box.

i. Available To
If a facility is going out of service permanently, for example a limousine that is
being disposed of, the enter the last day on which a booking may be made in this
box.  (If a facility is being taken temporarily out service use the Maintenance
Booking - see section 6.5 below)
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If your facility is a room it may have a number of different layouts, for example
boardroom layout, classroom layout or theatre layout.  Each of these layouts may have a
different capacity and they can take time to set up and tear down.

To enter a new layout click on the  New button to bring up the following window.

Enter a name for this layout, a capacity for the room when it is in this layout and,
optionally, an amount of time to set up and tear down.  The setup and teardown times
will set the values on the booking form when this layout is selected but they can be
changed.

Tick the box next to Default Layout if this is the layout that will be selected when this
facility is first chosen in a booking.
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If you have selected an availability of By Day of the Week or By Date and Time then
use the Availability page to enter the days or dates and times when this facility can be
booked.  If you have selected By Date and Time there will be a panel at the top headed
Week Beginning where you can select the week you wish to view and/or edit.  Click on

the  or  button to move back or forwards by a week, or click on the  button
to pop up a calendar to select a particular week.

To add one or more new sessions when bookings can be made click on the  New
button to produce the window below.

Select the day or days you wish to add a session of availability to, then select a start and
end time and click OK.
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To edit or delete a session of availability click on the session you wish to work with (the
border will get thicker) and then click on the  Delete button or the  Edit button.

The Features page enables you to select which features this facility has.  Click on one of

the Available Features in the list on the left then click the  to move the feature into
the Features of the Facility list on the right.
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Enter any notes you wish to make about this facility just type them into the Notes page.

On the Permissions page you can select the access rights for User Groups - see
Chapter 14 for more details about Access Rights and User Groups.

One you have entered all the details you want click the OK button and the new Facility
will appear in the Facility Column on the main screen.

4.5 New Resources

Resources (and Services) can be set up for use in all facilities or to be available only for
facilities within a particular folder.

If you wish to add a resource to a folder you must first make sure that the folder is set up
to contain resources.  See section 3.3 New Folders above.

To record a new Resource in the Facilities Column:

a. Right click on the Main or on the appropriate Folder line in the Facilities Column.

b. Click on New Item  3 New Resource  to open a Resource Properties Form,
ready to be completed.
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Note: When you first see the form, the "In
Folder" box is already complete,
based on where you obtained the
form from the Booking Chart.

c. Enter the Resource Name,  Resource Type, and Serial Number

d. Provided that the Resource already exists and will remain in your possession, place
a tick in the Always Available box.

e. Click the OK button to close the form.

4.6 New Services

To record a new Service in the Facilities Column:

a. Right click on Main or on the appropriate Folder Name to open a pop-up menu.

b. Select New Item 3 New Service to open a Service Properties Form.
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c. Fill in the Service Name, in Folder and Service Type as required.

d. Leave the Always available box ticked.

e. Close the form by clicking OK.

The other options available to services are:

a. Ask for No. Required
If your service is something like coffee where you can book a variable number then
select this option.

b. Allow different time to booking?
With a simple booking (or a booking wizard booking) a service is presumed to be
required at the same time(s) as the facility.  If you wish to be able to select a
different time for this service then select this option.

c. Get separate notes on simple booking
If you need to get additional information regarding a service when it is booked then
select this option.



Chapter

5
Making a Booking
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5 Making a Booking

5.1 Ways to make a booking

You can book a facility using one of four procedures which start from the Tool Bar or
from the Menu Bar:

a. calling for and completing a Simple Booking Form,

b. calling for and completing a Complex Booking Form,

c. calling for and completing a Maintenance Booking Form, and a

d. Booking Wizard, which leads you through a series of forms. 

Alternatively, for a single booking, you can start by drawing a Booking Bar straight onto
the Facility Line, as follows:

a. Locate the horizontal facility line adjacent to the name of the facility (in the
facilities column) that you wish to book.

b. Move the mouse pointer along the facility line until you come to the day and
time (as shown on the Timeline across the head of the chart) that you want the
booking to commence.

As you move the pointer across the booking chart a small box opens, from time
to time, showing the exact time and date that the pointer is indicating. 

c. Press the left mouse-button and keep it depressed as you move the pointer
along the facility line towards the right.

As you move the pointer now with the mouse-button depressed, the area of the
facility line over which it passes becomes  shaded: this is the Booking Bar.

d. When the pointer reaches the time and date that the booking ends, release the
mouse-button.

The moment you release the mouse-button, the Booking Bar becomes fixed, and
a New Simple Booking Form opens, on which the Facility Name; the start date
and time, and the finish date and time, are already recorded to reflect the
Booking Bar that you have just drawn.

Tip: This  method  calls for a steady hand, but it
may be worth considering because it is  quick
and graphic and because it shows you at once
if you are about to double-book a facility.
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Note: The booking form that opens when drawing a booking can be changed in the
User Settings.

5.2 Simple Booking

On starting a simple booking you will see a form similar to the one below.

On the Details page enter some or all of the following information.  These options may
or may not appear or may appear slightly differently depending on how you have set up
your User Settings.

a. Facility
Click on the down arrow button on the left of the Facility box to pop up the tree of
folders and facilities and select the facility you wish to book.

b. Layout
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Popup the list of layouts that are available for this facility and select the one you
want.

c. Booking Description
Enter a description of the purpose of the booking.  This description will be shown
on confirmations and the booking chart on the main screen (depending on User
Settings).

d. Booking Type
Select the type of booking from the list.  The colour associated with the booking
type will be used to determine the colour of the booking in the booking chart.

e. Our Reference
If you have a reference for the booking then enter it here.

f. Client Reference
If you have a client and they have a reference for this booking then you can enter it
here.

g. No of people
If the facility you are booking is a room then you may want to record how many
people will be using the room.  This number is checked against the maximum
capacity for the room (or layout) and if the number exceeds the capacity you will be
warned or prevented from making the booking depending on your User Settings.

h. On Behalf Of
If you are making this booking on behalf of someone else within your organisation,
you can select anyone from the users list here.

i. No Client/Client
If there is no client associated with this booking select No Client otherwise select
Client.  You can opt to have only one of these options available or choose which
one you wish to have selected as the default through User Settings.

j. Client Name
If you have select to have a client associated with this booking then you can either
pop up the list of clients and select the client or start typing the client name into this
box, Libris will find the first client that matches the letters you type until it finds the
one you want.  You view the details of the client you have selected by clicking on

the  Client Details button.  Alternatively, if you do not know precisely the name

of the client you are looking for you can use the  Find Client button.  If the

booking is for a new client you can enter the details from here by clicking on the 
 Add New Client button, see Chapter 10 for details on how to enter the client
details.

k. Client Contact
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If the client has more than one contact you can select which contact from the client
you are making this booking from the list of available contacts.

l. Frequency
If your booking is on a single day or for a continuous period the select Continuous,
if your booking occurs on a number of different days then select Multiple Days.

m. Booking Period
If you have selected Continuous in the Frequency box above, then you can enter
the date and time the booking will start with an amount of time for setup, if relevant,
and the date and time the booking will end with an amount of for teardown, if
relevant.

n. Print Confirmation
Tick this box if you wish a Confirmation to be printed out as soon as you complete
this booking.

o. Email Confirmation
Tick this box if you wish a Confirmation Email to be sent out as soon as you
complete this booking.

If you have selected Multiple Days in the Frequency box then a  Multiple Bookings
page will be available at the top of the window.
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On this page you can enter the various dates and time you wish to include in this
booking.  You can either add the dates one by one by selecting the date in the calendar
in the top left corner and then selecting the start and end times, and the amount of time
required for setup and teardown and then clicking the Add button; or you can add dates
by using the date wizard by clicking on the Wizard button (see below).  The dates and
times you have selected will be displayed in the list in the bottom half of the page.
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If you wish to add a
booking for every
available day between two
dates, select Every Day,
then select the start and
end dates of the period
and the times the booking
will start and end on each
day of the booking with
the amount of time for
setup and teardown on
each day.

If you wish to make a booking
once a week on the same day
each week then select Days of
the week.  Click on the day of the
week you wish to use then select
the start and end dates of the
period and start and end times as
before.  You can also choose to
make the booking every fortnight
or every 3 or more weeks by
selecting the number of weeks in
the Every ... week(s) box.
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If your booking occurs on
certain weeks every
month then select Weeks
of the month.  Click on
the day of the week you
wish to use and the week
or weeks you wish to use. 
For example, click Week 2
and Wednesday if you
wish your booking to be
every 2nd Wednesday, or
click Last Week and
Thursday if you wish you
booking to be on the last
Thursday of every month. 
Select dates and times as
before.

Click OK to add the dates and times to the list of dates on the booking form.  If there is
already a booking for one or more of the dates and times you have selected an error
message will appear.  Also, if one of the dates of the booking falls on a holiday that has
been marked to Prevent Bookings you will get an error message.  Such dates will not
be added to the list but all the rest will be.

If you wish to change one of the dates and times added, double click on the row you
wish to change to bring the details back into the top half of the screen, change the date
and/or times and then click the Replace button.  If you wish to remove one of the dates
and times click on the row you wish to delete then click the Remove button.
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You can book resources that you wish to use with or within the facility that you are
booking in the Resources page.  When you select the Resources page you will be
shown a list of resources that are contained in either the Main folder or the folder that
contains the facility you are booking (or the folder that contains the folder that contains
the facility, or so on up the hierarchy).  These resources will be grouped by resource
type.  Simply tick the resources you wish to book and they will be added to the list of
selected resources at the bottom of the page.  If a resource has already been booked
during one or more of the dates and times required, or one or more of the dates falls
outside the Available From and Available To dates of the resource, you will not be able to
tick that resource and the image next to it will appear with a cross through it .
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Similar to resources, services that you require with or in the facility can be booked on
the Services page.  You will see a list of services that are contained in either the Main
folder or the folder that contains the facility you are booking (or the folder that contains
the folder that contains the facility, or so on up the hierarchy).  These services will be
grouped by service type.  Simply tick the services you wish to book and they will be
added to the list of selected services at the bottom of the page.  If the service has been
set up to require additional information (number required, different booking time and/or
notes) a window will pop up for you to enter that information.
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If the service is required at a different time
to the facility you can enter a different start
and/or end time here.

If you need to know a number in relation to
the service (for things such as drinks or
sandwiches), then you can enter the
number here.

If you need further information in relation to
the service (such as the type of sandwich)
then you can enter that in the Notes.

If you have purchased the Attendees module you will have an Attendees page to enter
the names and contact details of all the people who will be attending the meeting or
session you are making this booking for.
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To add a new attendee click on the New button, to bring up the following window:

Enter the name of the attendee and,
optionally, a telephone number and email
address.  If you have selected in the User
Settings the attendees will be included in
the list of recipients of the booking
confirmation.
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If you wish to record any further information about the booking you can record this in the 
Notes page.

Once you have completed all the information you need, click the Save button.  At this
point Libris will double-check that the facility and resources are available and then record
the booking.

After the booking has been saved, if you have selected Print Confirmation a
confirmation will be printed and, if you have selected Email Confirmation a confirmation
email will be sent to all the parties in the booking (subject to the User Settings).  See
Chapter 7. for further details about booking confirmations.

Then a booking view will appear to allow you to review the information:
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5.3 Booking Wizard

Unlike the Simple Booking, the Booking Wizard enables you to book more than one
facility with one booking.  The Booking Wizard asks you to select the date(s) and times
you wish to book and will then allow you to select from those facilities that are available
at the time(s) selected.
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First, you need to enter the basic booking information: the client, description, references,
booking type, "on behalf of", notes and confirmations, as per the Simple Booking.

a. No Client/Client
If there is no client associated with this booking select No Client otherwise select
Client.  You can opt to have only one of these options available or choose which
one you wish to have selected as the default through User Settings.

b. Client Name
If you have select to have a client associated with this booking then you can either
pop up the list of clients and select the client or start typing the client name into this
box, Libris will find the first client that matches the letters you type until it finds the
one you want.  You view the details of the client you have selected by clicking on

the  Client Details button.  Alternatively, if you do not know precisely the name

of the client you are looking for you can use the  Find Client button.  If the
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booking is for a new client you can enter the details from here by clicking on the 
 Add New Client button, see Chapter 10 for details on how to enter the client
details.

c. Client Contact
If the client has more than one contact you can select which contact from the
client you are making this booking from the list of available contacts.

d. Our Reference
If you have a reference for the booking then enter it here.

e. Client Reference
If you have a client and they have a reference for this booking then you can enter
it here.

f. Booking Description
Enter a description of the purpose of the booking.  This description will be shown
on confirmations and the booking chart on the main screen (depending on User
Settings).

g. Booking Type
Select the type of booking from the list.  The colour associated with the booking
type will be used to determine the colour of the booking in the booking chart.

h. On Behalf Of
If you are making this booking on behalf of someone else within your organisation,
you can select anyone from the users list here.

i. Booking Notes
If you wish to record any further information about the booking you can record this
here.

When you have completed this information, click the Next button to move on to the next
page.

Next you are requested to enter the start date and time and the end date and time for the
booking, with an amount of time for setting up and tearing down, if relevant.
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If your booking is required for a number of days then click on the Repeat Bookings
button to switch to the Multiple Days page (see below).

Once you have entered the dates and times of your booking, click the Next button.

If you have selected the Repeat Bookings button you be moved on to the next page
automatically.

On this page you can enter a series of dates and times.
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This works the same way as the Multiple Bookings page of the Simple Booking form.
See the section 5.2 Simple Booking.

Once you have selected your dates and times you will now see the tree of facilities for
you to select those that you wish to book.
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Tick the boxes next to the facility or facilities you require and they will be added to the list
of Selected Facilities in the bottom half of the window.  If you wish to see the details of

a facility click on the  button next to it.

If a facility is unavailable for one or more of the dates and times you have selected you
will not be able to tick the box next to it an the icon will have a cross through it , and a
View Conflicts button will appear in top right of the window.  If you click on the View
Conflicts a window similar to the following will appear.
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Once you have selected the facility or facilities you require click the Next button to move
on to the next page.

This page allows you select the layout and number of people for each facility you have
selected.  You can also select resources for each facility.
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a. Layout
To select the layout, click on the layout next to the facility you wish to change, and
you can then drop down the list of layouts available for that facility.

b. No of people
Click on the number next to the facility you wish to and change and you can then
enter or select the no of people in that facility.

c. Resources
Click on the facility you wish to select resources for and you will then be shown a
tree with the resources available for that facility.  You will be shown a list of
resources that are contained in either the Main folder or the folder that contains the
facility you are booking (or the folder that contains the folder that contains the
facility, or so on up the hierarchy).  These resources will be grouped by resource
type.  Simply tick the resources you wish to book and they will be added to the list
of selected resources at the bottom of the page.  If a resource has already been
booked during one or more of the dates and times required, or one or more of the
dates falls outside the Available From and Available To dates of the resource, you
will not be able to tick that resource and the image next to it will appear with a cross
through it .

Click the Next button to move on to the next page.
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This page allows you to select the services you require in each facility you have booked.

First select the facility in the top left of the page.  You will see a list of services that are
contained in either the Main folder or the folder that contains the facility you have
selected (or the folder that contains the folder that contains the facility, or so on up the
hierarchy).  These services will be grouped by service type.  Simply tick the services you
wish to book and they will be added to the list of selected services at the bottom of the
page.  If the service has been set up to require additional information (number required,
different booking time and/or notes) a window will pop up for you to enter that
information.
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If the service is required at a different time
to the facility you can enter a different start
and/or end time here.

If you need to know a number in relation to
the service (for things such as drinks or
sandwiches), then you can enter the
number here.

If you need further information in relation to
the service (such as the type of sandwich)
then you can enter that in the Notes.

Once you have completed all the information you need, click the Finish button.  At this
point Libris will double-check that the facilities and resources are available and then
record the booking.

After the booking has been saved, if you have selected Print Confirmation a
confirmation will be printed and, if you have selected Email Confirmation a confirmation
email will be sent to all the parties in the booking (subject to the User Settings).  See
Chapter 7. for further details about booking confirmations.

Then a booking view will appear to allow you to review the information.

5.4 Complex Booking

If you wish to make a booking that has different facilities on different days, or has
different resources and/or services on different days, or you wish to book a resource or
service without a facility, then you need to use the Complex Booking form.
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First, you need to enter the basic booking information: the client, description, references,
booking type, "on behalf of", notes and confirmations, as per the Simple Booking.

a. Booking Description
Enter a description of the purpose of the booking.  This description will be shown
on confirmations and the booking chart on the main screen (depending on User
Settings).

b. Our Reference
If you have a reference for the booking then enter it here.

c. Client Reference
If you have a client and they have a reference for this booking then you can enter it
here.

d. Booking Type
Select the type of booking from the list.  The colour associated with the booking
type will be used to determine the colour of the booking in the booking chart.
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e. On Behalf Of
If you are making this booking on behalf of someone else within your organisation,
you can select anyone from the users list here.

f. No Client/Client
If there is no client associated with this booking select No Client otherwise select
Client.  You can opt to have only one of these options available or choose which
one you wish to have selected as the default through User Settings.

g. Client Name
If you have select to have a client associated with this booking then you can either
pop up the list of clients and select the client or start typing the client name into this
box, Libris will find the first client that matches the letters you type until it finds the
one you want.  You view the details of the client you have selected by clicking on

the  Client Details button.  Alternatively, if you do not know precisely the name

of the client you are looking for you can use the  Find Client button.  If the

booking is for a new client you can enter the details from here by clicking on the 
 Add New Client button, see Chapter 10 for details on how to enter the client
details.

h. Client Contact
If the client has more than one contact you can select which contact from the client
you are making this booking from the list of available contacts.

i. Same attendees for all bookings
If you have purchased the Attendees Module, you will see this option.  You can
between entering one set of attendees which relate to all dates and all facilities, or
you can elect to enter different attendees for each facility and/or set of dates.  If
you tick this box you will see an Attendees page at the top of the window, if you do
not have a tick in this box you will see an Attendees page on the Sub-Booking
form that you get on clicking the Add button.

If you the Attendees Module and have ticked the Same attendees for all bookings box,
as mentioned above, you can select the Attendees page as shown below.  On this page
you can enter the names and contact details of all the people who will be attending the
meeting or session you are making this booking for.
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To add a new attendee click on the New button, to bring up the following window:

Enter the name of the attendee and,
optionally, a telephone number and
email address.  If you have selected in
the User Settings the attendees will be
included in the list of recipients of the
booking confirmation.

If you wish to record any further information about the booking you can record this in the 
Notes page.

Once have you recorded the basic details of the booking, you now start to enter the
"Sub-Bookings" - details of the dates and times, facilities, resources and services you
require.  To enter a new Sub-Booking click on the Add button to get the Complex
Booking Items window.
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First select the facility you require, or No Facility, this facility is the one that will be
booked for all the dates you enter in this window.

a. No Facility
Select No Facility if you just wish to book resources or services.

b. Facility
If you have selected Facility click on the down arrow button on the left of the Facility
box to pop up the tree of folders and facilities and select the facility you wish to book.

c. Layout
If you have selected Facility pop up the list of layouts that are available for this
facility and select the one you want.

d. No of people
If the facility you are booking is a room then you may want to record how many
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people will be using the room.  This number is checked against the maximum capacity
for the room (or layout) and if the number exceeds the capacity you will be warned or
prevented from making the booking depending on your User Settings.

Now you can enter the various dates and time you wish to include in this booking.  You
can either add the dates one by one by selecting the date in the calendar in the top left
corner and then selecting the start and end times, and the amount of time required for
setup and teardown and then clicking the Add button; or you can add dates by using the
date wizard by clicking on the Wizard button (see below).  The dates and times you have
selected will be displayed in the list in the bottom half of the page.

If you wish to add a
booking for every
available day between two
dates, select Every Day,
then select the start and
end dates of the period
and the times the booking
will start and end on each
day of the booking with
the amount of time for
setup and teardown on
each day.
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If you wish to make a
booking once a week on the
same day each week then
select Days of the week.
Click on the day of the week
you wish to use then select
the start and end dates of
the period and start and end
times as before.  You can
also choose to make the
booking every fortnight or
every 3 or more weeks by
selecting the number of
weeks in the Every ...
week(s) box.

If your booking occurs on
certain weeks every
month then select Weeks
of the month.  Click on
the day of the week you
wish to use and the week
or weeks you wish to use. 
For example, click Week 2
and Wednesday if you
wish your booking to be
every 2nd Wednesday, or
click Last Week and
Thursday if you wish you
booking to be on the last
Thursday of every month. 
Select dates and times as
before.
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Click OK to add the dates and times to the list of dates on the booking form.  If there is
already a booking for one or more of the dates and times you have selected an error
message will appear.  Also, if one of the dates of the booking falls on a holiday that has
been marked to Prevent Bookings you will get an error message.  Such dates will not
be added to the list but all the rest will be.

If you wish to change one of the dates and times added, double click on the row you
wish to change to bring the details back into the top half of the screen, change the date
and/or times and then click the Replace button.  If you wish to remove one of the dates
and times click on the row you wish to delete then click the Remove button.

Once you have selected the facility and dates you require you can then select any
resources and/or services you need with or in this facility.

You can book resources that you wish to use with or within the facility that you are
booking in the Resources page.  When you select the Resources page you will be
shown a list of resources that are contained in either the Main folder or the folder that
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contains the facility you are booking (or the folder that contains the folder that contains
the facility, or so on up the hierarchy).  These resources will be grouped by resource
type.  Simply tick the resources you wish to book and they will be added to the list of
selected resources at the bottom of the page.  If a resource has already been booked
during one or more of the dates and times required, or one or more of the dates falls
outside the Available From and Available To dates of the resource, you will not be able to
tick that resource and the image next to it will appear with a cross through it 

Similar to resources, services that you require with or in the facility can be booked on
the Services page.  You will see a list of services that are contained in either the Main
folder or the folder that contains the facility you are booking (or the folder that contains
the folder that contains the facility, or so on up the hierarchy).  These services will be
grouped by service type.  Simply tick the services you wish to book and they will be
added to the list of selected services at the bottom of the page.  If the service has been
set up to require additional information (number required, different booking time and/or
notes) a window will pop up for you to enter that information.
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If the service is required at a
different time to the facility you
can enter a different start and/or
end time here.

If you need to know a number in
relation to the service (for things
such as drinks or sandwiches),
then you can enter the number
here.

If you need further information in
relation to the service (such as the
type of sandwich) then you can
enter that in the Notes.

If you have the attendees module and you have not selected Same attendees for all
bookings then you can enter a list of attendees that relate to this Sub-Booking here
(follow the instructions as above).
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If you wish to record any further information about this Sub-Booking you can record this
in the Notes page.

Once you have selected the facility, dates, resources and services that you require click
OK and the booking information will be added to the tree of bookings on the main
Complex Booking form.  You can now book further facilities and/or dates with resources
and/or services by clicking on the Add button again.

You can edit a booking for one facility on one date by clicking on the facility line
underneath that date and then clicking the Edit button.  You can then change the date,
times, resources and/or services.

Once you have completed all the information you need, click the Finish button.  At this
point Libris will double-check that the facilities and resources are available and then
record the booking.

After the booking has been saved, if you have selected Print Confirmation a
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confirmation will be printed and, if you have selected Email Confirmation a confirmation
email will be sent to all the parties in the booking (subject to the User Settings).  See
Chapter 6. for further details about booking confirmations.

Then a booking view will appear to allow you to review the information.

5.5 Maintenance Booking

If you wish to make take a facility out of service for maintenance you can make a
maintenance booking.  A maintenance booking just requires you to enter a start date and
time and an end date and time; you can also enter a description of the reason for the
booking and some notes.

5.6 Making a change to a booking

If you want to make changes to an existing booking you can do so in two ways.

a. Find the booking in the Booking Chart on the main screen.
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b. Point to the Booking Bar and Right-click to
pull down a menu of choices:

c. Select  Edit Booking to display the Booking Form that you filled in when
you created the record, showing all the booking information that has been
recorded to date.

d. Type in any information that you wish to add or change.

e. When you have made all your changes  click on the Save button at the foot of
the form.

Alternatively use one of the methods described in chapter 8. to find your booking and
then click on the  Edit Booking button.

If you have made a Simple Booking but need to adjust the details on one day of the
booking, for example changing the facility or services required, you may want to change
it to be a Complex Booking.  To do this right click on the booking in the Booking Chart

and select  View Booking, once the booking details have come up click on the 
Upgrade booking to a complex booking button.

Similarly if you have made a booking using the Booking Wizard and need to change
just one part of it, for example changing the facilities or resources booked on just one
day of the booking, you may want to change it to be a Complex Booking.  To do this

right click on the booking in the Booking Chart and select  View Booking, once the

booking details have come up select  Edit as Complex Booking from the File
menu.

Warning: Once you have switched a booking to being a complex
booking you cannot change it back to being a simple booking
or booking wizard booking.

5.7 Copying a booking

Sometimes you may wish to make a booking that is identical or similar to booking you
have already made.  As with changing an existing booking, first you need to find the
booking you wish to copy.
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a. Find the booking in the Booking Chart on the main screen.

b. Point to the Booking Bar and
Right-click to pull down a menu of
choices:

c. Select  Copy Booking to display the Booking Form that you filled in when you
created the record, showing all the booking information that has been recorded to
date.

d. Change the dates and/or facilities and any other details you want to be different.

e. When you have made all your changes  click on the Save button at the foot of the
form.

Alternatively use one of the methods described in chapter 8. to find your booking and

then click on the  View Booking button, if you are viewing a simple booking then

click on the  Copy Booking button, otherwise select  Copy Booking from the
File menu.

5.8 Deleting a booking

Occasionally you will need to cancel a booking, which means deleting the booking
recorded in Libris.

If you just wish to delete one day of a multiple day booking, or delete on part of a
complex booking you should follow the procedure in section 5.6. Making a change to a
booking above.

To delete an entire booking:

a. Find the booking in the Booking Chart on the main screen.

b. Point to the Booking Bar and Right-click to pull
down a menu of choices:
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c. Select  Delete Booking and you will be shown a booking view form with all the
booking information that has been recorded.

d. If you are sure this is the booking you wish to delete click on the Delete button at
the foot of the form.

e. If the User Settings have been set to send an email confirmation on cancellation, an
email similar to the original email confirmation will be sent out notifying all relevant
parties that the booking has been cancelled.

Alternatively use one of the methods described in chapter 8. to find your booking and

then click on the  Delete Booking button.



Chapter

6
Booking Confirmations



70 Libris 2

© 2003-2005 Crucial Software Ltd

6 Booking Confirmations

Once you have made a booking you may wish to print out the details of the booking as a
confirmation or to send an email to all the parties involved or providing services or
resources.

To print out a confirmation either tick the "Print Confirmation" box on the booking form to
get one printed as soon as you have clicked the save button, or, if you wish to print a
copy later view the booking and select the Print Confirmation option from the File menu
on the booking details form.

Similarly to send an email confirmation either tick the "Email Confirmation" box on the
booking form to produce an email as soon as you have clicked the save button, or, if you
wish to print a copy later view the booking and select the Email Confirmation option
from the File menu on the booking details form.  Depending on your System Settings the
email will either be produced and sent without any user intervention, or else an email
window will be displayed to enable you to add extra recipients or to adjust the text of the
email.

It is possible to have alternate layouts for the confirmations, look on the Crucial Software
web site for other options.

http://www.crucialsoftware.com/download_files/downloads.asp
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7 Navigating the booking chart

Once you have set up some facilities and made some bookings you should see a screen
similar to the one above.

On the screen, you can see only a relatively small part of the whole booking chart - there
just isn't room there to show it all at a scale that would be legible.  

You can imagine the complete chart as stretching unseen, beyond your monitor's
screen, from a distant past on the far left to an as yet undetermined future on the right,
the visible part showing, initially, today's date at the left of the window.

This section describes how to get to see the parts of the chart that are, at first, out of
sight.

To look at past dates click on the arrow on the left of  the base of the Booking Chart:

a. A click will move the Chart one hour or day to the right;

b. holding down the mouse-button will cause the Chart to continue to scroll (ie to
continue to move) to the right until you release the button.
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To look at future dates click on the arrow on the right of the base of the Booking Chart:

a. A click will move the Chart one hour or day to the left;

b. holding down the mouse-button will cause the Chart to scroll to the left.

To change the scale of the visible Booking Chart click on Zoom in the Tool Bar, to
reveal a menu offering you  Day, Week or Month:

a. Day will show a single day, divided into hourly sections, spread across the whole of
the visible section of the chart;

b. Week will show a period of just over a full week, divided into days, (like the example
above) and

c. Month will show a period of just over a month divided into days.

To enlarge the divisions on the scale click the + Magnifying Glass button on the Tool
Bar.  Continue to click until you have the scale that you want.

Note: If you increase the scale from one Week on screen, hourly divisions will first be
shown when only about four whole days are visible.

To reduce the divisions on the scale click the - Magnifying Glass button on the Tool
Bar.  Continue to click until you have the scale that you want.

To move to a specified date in the present month:

a. Move the mouse pointer to any position on the Time line and click to reveal a
calendar which shows the present month:

b. Move the mouse pointer to any date on the calendar and click .  The Booking Chart
will show that date on the left of the screen.

To move to a specified date in a another month:

a. Click on the Timeline to reveal a calendar showing the present month.

b. You can switch to another month by clicking on the left or right arrows at the top of
the calendar, or you can click on the month name to pop up a list of months to switch
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to.

c. Move the mouse pointer to any date on the calendar and click .  The Booking Chart
will show that date on the left of the screen.

To return to today's date :

a. Click on  the Time line to display a calendar.

b. Click on Today at the foot of the calendar.
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8 Clients

Libris has the facility for creating a permanent list of clients.  This provides you with a
single reference that you can add to and change whenever necessary, and can ensure
that, whenever you make a booking, or are in contact with your client, you always have
the most up-to-date information available to you.

It gives you, for example, the name and status of your contact, and keeps postal and
email addresses.  It also gives you space to make and keep any notes and reminders
that you would like to have available whenever you are talking with your contacts.

8.1 The Client List

To display the Client List select Tools 3 Client from the Menu Bar on the main form.

The list that you see has two functions:

a. it shows brief information about each client, and

b. it is a convenient way to access the full record in order to see more information or
to make changes to it.
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At the head of the Client List there is a Tool Bar which enables you to add to or change,
search or print out the list.  The functions of the buttons are described below.

Click the new (empty) page button to create a new Client.

This button opens an existing Client to enable you to make changes to it.

This button deletes the Client, and should, naturally be used with caution as it
may remove information to which you would later wish to refer.

This button allows people simply to look at a Client without making any changes
to them at all.

Note: In an environment in which several people have access to Libris
records, the first three buttons can be made unavailable to people who
should have viewing rights only; so that changes to the list may only
be made by those who have Supervisor or Booking Manager status. 
See chapter 11. Access Security for more information.

This button, when clicked, gives entry to a Client Search facility which is
described later in this section.

This button leads to the Booking Search facility which is the subject  of the next
section.

This button gives access will print out the Client List as it appears on screen.

This button opens a window in the lower right corner of the Client List, which
enables you to add and/or remove columns from the client list.

This button accesses a facility for transferring the Client List, as a file, to another
application, having been reformatted appropriately.
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When your client list has grown to a size that makes it difficult to scan it all, you may
need to use the client search (detailed in section 8.3 Searching for Clients below), or
by re-sequencing the Client List.

To re-sequence the Client List:

a. Choose the column by which you wish to re-sequence the list (for example, the Client
Number)

b. On the Title Bar, just above the list, click on the column heading of your chosen
column.

The list will be immediately re-sequenced and a small indented arrow mark will be left on
the Title Bar, upward for an ascending sort, and downward for a descending sort. 
Starting with the arrow pointing upwards, its direction, and the sequenced of the list, will
be reversed with each subsequent click.

Note: You may also rearrange the columns by dragging (hold down the left mouse
button and move the mouse) the column headings.

8.2 New Clients

You can enter new clients from 2 places, either select the Clients option from the Tools

menu on the main screen to bring up the Clients windows and then click on the 

New Client button, or else click on the  Add New Client button on any booking form.
Once you have done this you will see the New Client form.
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Here you can select whether the client is a company or an individual and then enter the
relevant details including up to 2 addresses.  On this page you can enter the details of
the main contact but you can also enter additional contacts by clicking on the Contacts
tab at the top of the form to see the Contact pages.
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Here you can enter additional contacts, change their details or delete contacts who are

no longer with the client.  If you click on the  New Contact button you will see the
New Contact window.
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Here you can enter the details of the contact plus their contact details.  Then click OK to
save them.

8.3 Searching for Clients

On the Tool Bar above the Client list, click on the Client Search button to reveal the
Client Search Form, which enables you to enter your search parameters:

Using the Client Search Form will deliver to you a Client List with a reduced number of
entries according to how stringently you specify your requirements.  If you know the
exact name of the Company, for example, that may be enough to take you straight to
your target.  When there are several locations for the same organisation, you may be
able to see the complete list; or you may want to see a single result and are able to
narrow down your search by quoting a part of the Post/Zip Code.

The Search Facility that Libris offers you is very adaptable, and the more you use it, the
more you will come to know how much or little you need to enter to get the results that
you need, given the size of your Client List.

When you commence your search, you may or may not be able to remember the
information you want to find your Client at once.  For example, you may be able to
remember only that it you are looking for a car dealership, containing the word "car" and
that your contact's name reminds you of gin.  Libris does not come equipped with a list of
drinks, but it does allow you very easily to keep perming some name that contains "Cars"
with Booth, Beefeater, Holland etc, until you remember Mr Gordon.
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9 Finding Bookings

9.1 Booking Search

To display the client search click on the Booking Search  button on the tool bar above
the main booking chart.

The booking search gives you several different options in searching for a booking.

The main options are to view bookings of facilities, resources or services by choosing
"Facility Selection", "Resource Selection" or "Service Selection" respectively. 
Additionally, if you have select "Facility Selection" you can also choose to include related
service or resource bookings by ticking in "Included Services" or "Included Resources".

a. If you know the period in which you booking falls, or you wish to restrict your
enquiry to a particular period then enter the"Start Date" and "End Date".
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b. If you wish to see one particular booking and know the number then just enter
the booking number.

c. Proceed by entering any pertinent information that would help identify your
bookings such as:

i) Booking Description - This will generate a list of all bookings that include
a matching booking description to the one entered.  You can choose from
three options: if you know the precise description of the booking then
select "Exactly matches", if know how the description begins select
"Begins with", or if you want to find all bookings that have one word or
phrase somewhere in the description then select "Contains".

ii) Client Reference -  This will generate a list of all bookings that match what
you enter.  This has the same options as the Booking Description.

iii) Our Reference - This will generate a list of all bookings that include a
matching "Our Reference" as any entered on the booking form.

iv) Booking Type - This will generate a list of all bookings that include a
matching "Booking Type" as any entered on the booking form.

v) Booked By - This will generate a list of all bookings made by a specific
person.

vi) On Behalf Of - This will generate a list of all bookings that include a
matching on behalf of entered on the booking form.

vii) Client - This will generate a list of all bookings that include a all bookings
for a specific "Client" during that specific time period.

viii) Facility - If you wish to see bookings for just one facility or just the
facilities in one folder, then select this here.

ix) Facility Type - Select the type of the facilities that you wish to see
bookings in.

x) Resource - If you wish to see bookings for just one resource or just the
resources in one folder, then select this here.

xi) Resource Type - Select the type of the resources for which you wish to
see bookings.

xii) Service - If you wish to see bookings for just one service or just the
services in one folder, then select this here.
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xiii) Service Type - Select the type of the services for which you wish to see
bookings.

If you have the attendees module you can also choose to see bookings with a
particular attendee by entering:

xiv) Attendees Title - This will generate a list of specific bookings with the title
of Mr. Or Ms.

xv)  Attendees First Name - This will generate a list of all booking that include
an attendee with a  matching first name.

xvi) Attendees Last Name -  This will generate a list of all bookings that
include an Attendee with a matching last name.

Once you have entered all of your pertinent information click on the OK button.  You will
then get a "Booking List" of bookings that match all of the criteria you have entered.  You
can sort, analyse and print the bookings that are found once the booking list appear, see
below.

9.2 Booking List

Once you have completed the booking search form you will get a form listing all the
booking that match the parameters you have entered.  You can further analyse these
bookings into groups, choose which columns you wish to see and then print the list or
export it to an Excel file or an HTML file for publishing to a web site.

If you wish to resequence the bookings by, for example, the start date click on the
column heading of the start date column and the bookings will be sorted in ascending
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order of start dates and you will see a  symbol in the heading; click on the column
heading again to sort in descending order and you will see a  symbol in the heading.
If you wish to order the bookings by start time, in addition to start date, hold down
the shift and then click on the column heading of the start time column and you
will see a  symbol in the heading of this column also.

If you wish to group the bookings for each facility, for example, together drag the Item
Name column header into the dark grey box above the headings (click on the column
heading and keeping the mouse button down move the mouse).  The booking list will
then produce a list of Facilities; click on the  button next to each facility to see a list of
bookings in that facility underneath it.

To change the sequence of the columns drag the column
heading to the position you want it to be in.



87Finding Bookings

© 2003-2005 Crucial Software Ltd

You can also remove columns that you do not require

or add columns that are missing by clicking on the 
customise button to produce a list of available columns. 
To add a column from this list drag it to the position you
require it in the column headings.  To remove a column
drag the column heading into the column list window.

You can also view, edit or delete a booking from here by clicking on that booking and

then clicking on the  View Booking,  Delete Booking or  Edit Booking
button.

If you wish to print the list you have 2 options: the  Print button will print the list in
colour with each line having a background in the colour of the booking type of that

booking; the  B&W Print button will print the list strictly in black and white.

To export the list to a file click on the  Export button and then select the type of file
you wish to save, then you will be asked the name of the file and where you wish to save
it.

9.3 Facility/Resource/Service Booking List

An alternative way of quickly viewing the bookings for a particular Facility, Resource or

Service, is to click on the selected item in the main form and then click on the  View
Bookings button.  This will bring up the Booking Search window already selected with
the item you have chosen; you can narrow down the search further if you wish then just
click on the OK button to produce the list.
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9.4 Client Booking List

Similar to the lists mentioned in c. above you can view a list of bookings for a particular
client by selecting the client in the Clients window (select Clients from the Tools window

in the main screen) and then clicking on  Client Bookings button.  This will bring up
the Booking Search window already selected with the client you have chosen; you can
narrow down the search further if you wish then just click on the OK button to produce
the list.

9.5 User Booking List

Again to the lists mentioned in c. and d. above you can view a list of bookings made by
or on behalf of a particular user by selecting the user in the Users window (select Users

from the Tools window in the main screen) and then clicking on  User Bookings
button.  This will bring up the Booking Search window already selected with the user you
have chosen; you can narrow down the search further if you wish then just click on the
OK button to produce the list.
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10 Reports

You can print or email reports by select Reports from the Bookings menu on the main
screen.  You will then see a list of available reports, possibly in different groups.  

First click on the group in the left hand panel of the Reports window, then click on the

report you wish to print or email in the right hand panel, then click on the  Print

Report,  Preview Report or  Email Report button.
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With list and calendar reports you can
choose whether to include or exclude some
information from the reports by clicking on

the  Report Options buttons.  This will
bring up a list of available report elements;
simply tick the boxes next to those you
require and untick those you do not require
and then click OK.  Now reports will not
include any elements that did not have ticks.

Occasionally new or updated report layouts are available on the Crucial Software web

site.  You can create a new group of reports (or Report Folder) by clicking on the 

New Folder button.  You can then load a report template by clicking on the  Load
Template From File button and then selecting the report template file (with an LRP
extension).  If you have an updated report template then you should either delete the old
template (by clicking on the  Delete Report button), rename it or move the template to
a group named something like Backup (you can move a template to another group by
dragging the report name from the panel on the right over the group name in the panel
on the left).

http://www.crucialsoftware.com/download_files/downloads.asp
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11 Holidays

Holidays can be used for two purposes in Libris: the first is to just name and highlight
particular days on the booking chart, and the reports; the second is to prevent people
from making bookings on selected dates, such as public holidays (where applicable).

To display the Holidays screen, go to the menu bar at the top left-hand corner of the
main booking chart.  Click on Tools.  A drop down menu will appear.  Click on the
Holidays option.

Note: You must have administrator rights to be able
to access this section of the Libris system.

To create a new Holiday:

a. Select the appropriate date in the Holidays window.

b. Click on the Add a new Holiday  button in the the menu bar on the Holidays
window.

c. The "Create A New Holiday" window will appear.

Alternatively just double click on the date in the list.
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Confirm the date of the Holiday is correct.

a. Enter the Name of the Holiday or Event.

b. If this Holiday or Event occurs every year on
the same date, check the box entitled "Same
date every year".

c. If you want to stop people from booking on
this Holiday or Event check the box entitled
"Prevent Booking"

d. To apply a special color coding to this day
make sure the "Default Color" box is not
checked.  Then select a fitting color for your
Holiday or Event.  This color will show on that
date in the booking chart on the main screen.

When complete, click OK
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12 Billing Module

The billing module provides the ability to generate simple invoices.  One invoice will relate to one
booking, i.e. you cannot have an invoice for just one part of a booking, nor can you have one
invoice combining a number of bookings.

12.1 Installing the Billing Module

There is no need to install the billing module, it is included within the standard Libris package, all
you need to do is switch it on.  To do this you will need to get a Licence Key from Crucial Software.
Once you have a licence key all you need to do is enter it into Libris.

Select "Add Licence" from the Help menu and then type in the
licence key.

Click OK.  Then close Libris and restart it you should now have the billing module enabled.

To check this out go to the Help
menu and select About.  The
Billing module should now be
shown as ticked, see example
below.
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12.2 Setting up Billing Module

Before you can generate invoices, there are three things you need to set up:

1. First you need to set up the Invoicing Options.  Select System Setup from the Tools, then
click on System Settings in the list on the left.

Options in here will include: a default tax (or VAT) rate, allowing discounts, adjustable tax
rates, and allowing deposits.  More may be added later, check the System Setup screen
for the latest options.

2. You will need to set up one or more Invoice Types.

3. The you will need to set up the pricing options and all facilities, resources and services that
you wish to bill for.
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12.3 Invoice Types

Before you can use the billing module, you need to determine what invoice types you wish to use. 
You must have a least one invoice to generate an invoice.

Invoice Types can be used to represent many things.  You may wish to use them just for reporting
and enquiry purposes, or else they can be used to have different pricing options (see Facility
Pricing Setup, Resource Pricing Setup and/or Service Pricing Setup for more information).

To set up invoice types, select System Setup from the Tools menu, and then click on Invoice
Types in the list on the left.

To create a new invoice type, click on the  "New Invoice Type" button.

Type in the name for the Invoice Type and click OK.

Add as many invoice types as you think you will need and then close System Setup.
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12.4 Facility Pricing Setup

If you charge for the use of each facility you will need to set up the prices and how those prices are
used to calculate the amount on each bill.

In the main Libris screen, right click on the facility you wish to setup and select Edit Item, then click
on the Pricing tab at the top.

In the pricing page you will find a line for each invoice type you have set up, this way you can have
different pricing for different circumstances.

You have four settings you have to select.

1) Price.  Here you enter the price that will be charge multiplied depending on the Period and Rate
settings.

2) Period.  You have a choice of "per booking", "per day" and "per hour".  These work as follows:
a) Per booking.  The price you have entered in the "Price" will be charged no matter how long

the booking lasts.
b) Per day.  The price you entered in the "Price" column will be multiplied by the number of days

the booking lasts for, no matter how long the booking lasts on each day.
c) Per hour.  The price you entered will be multiplied by the number of hours the booking lasts

for.  So, for example, if a booking lasts for 3 hours on each day for four days, the price will be
multiplied by 12.

3) Rate.  You have two choices: "per booking" and "per person".  If your rate depends on the
number of people in the room the select "per person" and the price you entered in the "Price"
column will be multiplied by the number of people selected on the booking form.
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4) Tax.  You have three options:
a) Exempt.  This means no tax (or VAT) will be charged for this facility.
b) Excluding Tax.  This means that tax (or VAT) will be added to the price entered here using

the rate set up in the System Settings.
c) Including Tax.  This means that tax (or VAT) is included in the price entered here.

You must enter a value in the "Price" column to ensure that this facility will be included when you
generate the invoice.

Note: The price can be overridden on the invoice form, but the Period, Rate and Tax settings
cannot.

12.5 Resource Pricing Setup

If you charge for the use of each resource you will need to set up the prices and how those prices
are used to calculate the amount on each bill.

In the main Libris screen, right click on the resource you wish to setup and select Edit Item, then
click on the Pricing tab at the top.

In the pricing page you will find a line for each invoice type you have set up, this way you can have
different pricing for different circumstances.

You have four settings you have to select.

1) Price.  Here you enter the price that will be charge multiplied depending on the Period and Rate
settings.

2) Period.  You have a choice of "per booking", "per day" and "per hour".  These work as follows:
a) Per booking.  The price you have entered in the "Price" will be charged no matter how long

the booking lasts.
b) Per day.  The price you entered in the "Price" column will be multiplied by the number of days
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the booking lasts for, no matter how long the booking lasts on each day.
c) Per hour.  The price you entered will be multiplied by the number of hours the booking lasts

for.  So, for example, if a booking lasts for 3 hours on each day for four days, the price will be
multiplied by 12.

3) Rate.  You have two choices: "per booking" and "per person".  If your rate depends on the
number of people in the room the select "per person" and the price you entered in the "Price"
column will be multiplied by the number of people selected on the booking form.

4) Tax.  You have three options:
a) Exempt.  This means no tax (or VAT) will be charged for this facility.
b) Excluding Tax.  This means that tax (or VAT) will be added to the price entered here using

the rate set up in the System Settings.
c) Including Tax.  This means that tax (or VAT) is included in the price entered here.

You must enter a value in the "Price" column to ensure that this resource will be included when you
generate the invoice.

Note: The price can be overridden on the invoice form, but the Period, Rate and Tax settings
cannot.

12.6 Service Pricing Setup

If you charge for the use of each service you will need to set up the prices and how those prices
are used to calculate the amount on each bill.

In the main Libris screen, right click on the service you wish to setup and select Edit Item, then
click on the Pricing tab at the top.

In the pricing page you will find a line for each invoice type you have set up, this way you can have
different pricing for different circumstances.
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You have four settings you have to select.

1) Price.  Here you enter the price that will be charge multiplied depending on the Period and Rate
settings.

2) Period.  You have a choice of "per booking", "per day" and "per hour".  These work as follows:
a) Per booking.  The price you have entered in the "Price" will be charged no matter how long

the booking lasts.
b) Per day.  The price you entered in the "Price" column will be multiplied by the number of days

the booking lasts for, no matter how long the booking lasts on each day.
c) Per hour.  The price you entered will be multiplied by the number of hours the booking lasts

for.  So, for example, if a booking lasts for 3 hours on each day for four days, the price will be
multiplied by 12.

3) Rate.  You have three choices:
a) Per unit.  This is the usual option for a service when you have selected the "Ask for no

required" option when setting up the service.  This means that the price relates to each unit of
the service supplied.  For example, if your service is "Coffee" and you charge for each pot of
coffee then you would select this option and put in the price per pot.

b) Per person.  If your rate depends on the number of people booked in the room the select "per
person" and the price you entered in the "Price" column will be multiplied by the number of
people selected on the booking form.

c) Per booking.  Select this if you do not charge depending on the number of people or the
number of the service you have booked.

4) Tax.  You have three options:
a) Exempt.  This means no tax (or VAT) will be charged for this facility.
b) Excluding Tax.  This means that tax (or VAT) will be added to the price entered here using

the rate set up in the System Settings.
c) Including Tax.  This means that tax (or VAT) is included in the price entered here.

You must enter a value in the "Price" column to ensure that this service will be included when you
generate the invoice.

Note: The price can be overridden on the invoice form, but the Period, Rate and Tax settings
cannot.

12.7 Generating an Invoice

There are two ways to generate an invoice.

First when entering or editing a booking you will see a tick box at the bottom of the screen:

tick this and an invoice will be generated when you click the Save or
Finish button.

Or if you want to generate and invoice for a booking that has already been created, view the
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booking from the booking chart or using the Booking Search, then click on the  View Invoice
option.  You will see the invoice, but it will show that "No Invoice has been generated", so you will

need to click on the  Generate Invoice button.

When the invoice screen comes up you can now adjust the invoice.  The first thing to do is select
the invoice type and the invoice date.  Once you have done this, you can adjust the Item Price of
each item (Facility, Resource or Service) on the invoice.  You can also add a discount, adjust the
Tax (or VAT) rate and put in a deposit (depending on your System Settings).  Once you have
finished, click on the OK button.

You should now see the Invoice View screen.  From here you can print the invoice, view payments
and add payments.

12.8 Editing an Invoice

To edit an invoice, view the booking from the booking chart or using the Booking Search, then click

on the  View Invoice option.  You will see the invoice details, now click on the  Edit Invoice
button.  The process is now the same as Generating an Invoice.
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12.9 Entering Payments

You can enter payments directly from viewing the booking or viewing the invoice by clicking the 
Make Payment button.

Enter the date of payment and the amount received and click on OK.

Or else you can view the payments relating to a booking/invoice by clicking on the  View

Payment button, and from here you can also make a payment using the  Make Payment button.
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12.10 Searching for Invoices

To search for an invoice or to produce simple billing reports, select
Invoice Search from the Tools menu on the main Libris screen.

You can now enter a number of parameters to find the invoices you are looking for:
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Once you have entered the criteria you wish to use to search, click on OK and you will then get a
list of all invoices that match your criteria.

From here you can view or edit the invoice or booking by clicking on the buttons in the toolbar. 
You can also adjust the columns, print the list or export it to Excel.  These options are the same as
with the Booking List, see that section for more details.
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12.11 Billing Reports

To be completed.
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13 Web Viewer

If you have purchased the Web Viewer this gives an unlimited number of users simple read access
to the Libris Schedule.  The Web Viewer shows bookings that are of booking types that are
published on Facilities that are published.

13.1 Setting Up Web Viewer

Once you have installed the Web Viewer, see Chapter 2., you need to set up which folders,
facilities and booking types are published on the Web Viewer.  Everything defaults to NOT being
published, so if you try to use the Web Viewer before performing this step you will see no facilities
or bookings.

Note: You will need to make sure you have installed the Web Viewer licence key.  You can
check this by looking on the About screen - select About from the Help menu (in the
Windows Libris client) and check which modules are installed.

To set up a folder on the Web Viewer, in the Windows Libris client, right click on a folder you wish
to publish, select Edit item and the tick the "Show Folder in Web Viewer" box.

To set up a facility on the Web Viewer, first make sure all folders that it is contained in are
published by following the procedure above, then right click on the facility on the main Libris screen
and select Edit Item, then tick the "Show this facility in the Web Viewer" option.

To allow you to make some booking invisible to the Web Viewer you can select which booking
types are published on the Web Viewer.  Select the System Setup option from the Tools menu and
click on the Booking Types option on the left.
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Select the booking type you wish to publish and the click on the  Edit/View Properties button.
Then tick the "Show bookings of this type in the Web Viewer" box.

13.2 Using the Web Viewer

To use the Web Viewer, open up your web browser (Microsoft Internet Explorer 5.0 or later, or
Mozilla Firefox) and enter the address of the server where the Web Viewer has been installed.

You will be asked to select whether you
want a day view or week view.

You will then see a list of all the facilities with a chart showing all the booking for the current day or
week.
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You can changes the date viewed by using the calendars at the top of the screen, or the Next
Week and Last Week buttons.

You can open and close folders by clicking on them.

To see details about the facility, click on the facility name, or to see a list of bookings for that facility

click on the  View Bookings button.
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To view brief details of a
booking, just hold the mouse
cursor over the booking on the
chart.

You can see further details by
clicking on the booking.

You can see other details of the
booking by clicking on the tabs
across the top of the screen
(Resources, Services, Attendees
and Notes).
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14 Access Security

The list of users is made up of those people that are going to use Libris to make or view
bookings, or those people within your organisation who will have bookings made on their
behalf ("users" do not necessarily have to use Libris).  There are 4 security levels for
users, each having different levels of access to functions within the system:

Administrator: Administrators can access every function in the system, including
changing system settings, create and change facilities, resources,
services, users, etc.

Booking Manager: Booking Managers can edit and/or delete any booking in the
system including historic bookings.

Standard: Standard users' access is determined by the User Group they
belong to.  By default they can make bookings and edit those
bookings before they have started.

Enquiry Only: These users can only search for and look at bookings and run
reports

14.1 User Groups

You can set up a number of user groups that have different levels of access to different
folders and facilities.  For example, if you have 2 folders representing 2 different offices
you may wish to have a User Group for each folder giving standard access to the folder it
relates to and enquiry only access to the other.
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14.2 New Users

To add a new user to the system select Users from the Tools menu and then click on
the  New User button to bring up the New User window.

User ID The identity that the user
will use to access Libris (or
their Windows user identity
if  you have chosen the
system setting for Libris to
use Windows identity
automatically).  If this user
will never use Libris just put
anything in here.

User Name The name of this user to be
displayed on booking
forms, confirmations,
enquiries and reports.

Security Level See above

Email Address The email address of this
user to be used for email
confirmations if they are
involved in a booking in
some way.  This field is
optional.

User Group If the Security Level is
Standard then you will
need to select a User
Group (see above for more
details).
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